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Installing The Protected Lands CatalogueInstalling The Protected Lands Catalogue  

  
Before installing the Protected Lands Catalogue, please read 
the associated “Read Me” text file and the License Agreement. 
 
To install the Protected Lands Catalogue on your local 
computer, simply run the Setup program titled “PLC v3 Setup” 
directly from the Installation CD. If you’ve downloaded it from 
the “BC Lands In Trust Registry” website, simply run it from 
wherever you’ve chosen to save it to. The application will 
automatically be saved to your Program Files Directory: 
C:\Program Files\Protected Lands Catalogue v3\.  
 
Within this folder, a directory called “Export Folder” is created. 
This is where files that will be sent to the Land Trust Alliance 
are stored. Please see the “Exporting To the Land Trust 
Alliance” section for details. 
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Protected Lands Catalogue OverviewProtected Lands Catalogue Overview  
  

Most of the instructions in this manual are available in the “PLC 
Help” section of the Protected Lands Catalogue application. 
Either select “open help” from the ‘Help’ menu, or click on the 
“PLC Help” button found in the upper left corner of most of the 
forms. 

 
GeneralGeneral  
The Protected Lands Catalogue is a database program 
originally designed in FileMaker Pro. Version 3 consists of 23 
related databases. This structure allows one-to-many 
relationships, which means that several files in one database 
can be linked to one record in the "master" file, which in this 
case is a specific property in the "Registry" section of the 
program. In other words, all data entered into the application, 
will be associated and linked to one specific Protected Area. 
 
Many of the familiar features common to most "MS Windows" 
applications are also available in the menus at the top of the 
screen. Although using the blue buttons within the application 
'forms' is considered to be good practice, there are many 
options available in the windows menus, which are not 
available in the forms. For example, to exchange data with this 
and other applications, use the Import and Export commands 
in the 'file menu'. As well, record and window navigation and 
other database commands are also available. 

  
StructureStructure  
The PLC application is made up of a 
“Registry” section and a “Land Trust” 
section. You can toggle between these 
forms with the button in the upper and 
bottom right corner of main application form.  
This Users Guide does not go into specifics about each 
database in the Protected Lands Catalogue. Contact Technical 
Support if you need clarification about any of the forms. 
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The Registry SectionThe Registry Section  
Most of the fields in the main “Registry” form contains general 
information about the protected area, and will be exported to 
the Land Trust Alliance of BC when submitting your data to the 
Provincial Registry. 
Databases in The Registry Section include 
• Protected Lands Catalogue 
• Locations 
• Parcels (one-to-many) 
• Ecosystems 
• Red Listed Species 
• Other Sensitive Features 

• Covenant Specifics 
• Fee Simple Specifics 
• Stewardship Specifics 
• Management Plans 
• Acquisition Partners 

(one-to-many)  
  
Important Fields for the Provincial Lands In Trust Important Fields for the Provincial Lands In Trust 
RegistryRegistry  
Although all the information accessed through the main 
“Registry” form is important to submit, please pay particular 
attention to the following sections/fields: 
A) Agreement Type 
B) Site Description 
C) Location & Location Coordinates (UTM or Lat./Long.) 
D) Ecosystem Description 
E) Red Listed Species and Other Sensitive Features 
F) Protected Values 
G) Area Protected 
H) Land Use Designation 
I) Covenant and/or Fee Simple Specifics 
 
The Land Trust SectionThe Land Trust Section  
This section is designed for the Land Trust to store, index and 
catalogue various pieces of information and documents 
related to a protected area, and will not be sent to the Land 
Trust Alliance of BC. 
 Databases in The Land Trust Section include

• Annual Activities 
• Restoration 

Activities 
• Tax Details 
• Property Incidents  
• Airphotos 
• Contact Information 

• Land Holder 
Contact Log 

• Finance Log 
• Reports 
• Maps 
• Photos 
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Updating Data From Version 2Updating Data From Version 2  
  
Version 3 of the Protected Lands Catalogue has been designed 
to easily import your information from version 2. If you are still 
using version 1.1, please contact Technical Support for 
directions 
  
Updating InstructionsUpdating Instructions  

1. Generally, you must first use the “Show All and Exit” 
script in version 2 to make your previous data available 
to import into version 3. 

2. Install the new version of the Protected Lands 
Catalogue v3  

3. Open the older PLC v2.1/2.12 application 
4. In v2.12, from the 'Scripts' menu at the top of the 

screen, choose the "Show All and Exit" command. 
5. Return to the newer version (v3), of the PLC 
6. From the 'PLC' menu at the top of the screen (where the 

'scripts' menu was), choose the "Update all Records" 
command and follow directions. 

7. You will have to browse to your older version's program 
folder found at: C:\Program Files\Protected Lands 
Catalogue v2.12\ 

8. Choose files of type "All Files" from the drop-down list, 
and select the file: "ProtectedLandsCatalogue.lit" and 
follow directions. 

9. Note: Do Not Select the "Protected Lands Catalogue 
v2.12.exe" file above it, as the updating process will not 
work with this file! 

10. Verify that all of your records have been successfully 
imported into the newer version of the application. 

  
Remove Version 2 From Your ComputerRemove Version 2 From Your Computer 
First verify that all of your information has successfully made 
the transition to Version 3. Next, use the “Add/Remove 
Programs” command in your “Control Panels” (Start button-
>Settings) to remove version 2.1 from your computer. 
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Data EntryData Entry  
  
About FieldsAbout Fields  
As the user, you enter data into fields. Select which field you 
wish to enter data into by clicking in it, or by using the “Tab” 
key to go through the “Tab Order”. Use the “Shift+Tab” keys to 
go in the reverse order, usually upward in a form. 
  
Common Field TypesCommon Field Types  
Text: Any combination of text and integers may be entered. 
Number: Only numeric digits may be entered. 
Date: Enter data in the Month/Day/Year Month/Day/Year format. 
Container: Use these fields to attach any type of file which is 
related to a specific entry. For example, .jpg pictures, MS Word 
documents, other database files or any other type of file or 
object can be attached. 

How To Use Container FieldsHow To Use Container Fields  
1. With the mouse, Right click in the File or Photo 

“Attachment” field. 
2. Choose the type of media you wish to attach from 

one of the “Insert” options. 
3. If you choose to “Insert Object”, you can either 

create a new document/file by selecting the type of 
file to create, or you can use the “Create From File” 
option to browse to an existing file on your 
computer. The other options are described within 
the file attachment dialogue box. 

  
  
PopPop--Up Lists and MenusUp Lists and Menus  
If there is a specific list of items to choose from, there will 
usually be a “pop-up” list or menu, where you can select a 
specific option. 
You may select multiple items in a pop-up menu by holding 
down  the “Shift” key while highlighting additional selections. 
  
Radio ButtonsRadio Buttons  
 When Radio Buttons are used, such as in the “Reports” 
section of the Protected Lands Catalogue, you will be able to 
more easily see what the complete array of options are. Again, 
you can use the “Shift” key to choose multiple selections. 
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Navigating/Browsing RecordsNavigating/Browsing Records  
  
Navigate through your records by using the blue navigation 
buttons or by clicking on the pages or slider of the 
rolodex/navigation book in the upper left corner. Alternatively, 
use the “Ctrl+ �” or “Ctrl+ �” Keys to scroll through your 
entries.  

 
Use the “ Browse Entries ” button to display an alphabetical 
listing of all the records/properties in the database. In the 
“Browse Entries” mode, highlight a specific property by 
clicking on it, then click the “View Details” button to go to the 
main Registry form for that file. 
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Adding and Deleting EntriesAdding and Deleting Entries  
  

Use the blue “Add” and “Delete buttons in the main “Registry” 
form to add and remove entries from your database. 
 
To Delete multiple records To Delete multiple records   
Select the appropriate “Delete” command from the ‘Records’ 
menu at the top of the screen. 
Delete Found Records: This command will be visible when 
there are records in the “found set”, and will delete only these 
found records. 
Delete All Records: Visible when all records are shown, and 
will delete all records in the database. 
 
See the next section “Finding and Sorting” for further details. 

Add
Delete
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Finding RecordsFinding Records  
About Finding and SortingAbout Finding and Sorting   
The status of the current find request or the 
sort order is displayed beneath the navigation 
book in the upper left corner of the screen. 
Records: The total number of records in the 
database 
Found: The number of records selected, 
based on a find request or relationship. 
Unsorted/Sorted: Indicates the sort status 
 
To Select All Entries:To Select All Entries:  
In any form or "table view" simply type  
Ctrl+J", or select "Show All Records" from the 
'Records' menu.  This will allow you to view and work with all 
the entries in the database. 
 
To Find Entries Based On Data:To Find Entries Based On Data:   
1. Go to the Registry Section and click the Find Mode  button on 

the right side of the layout. 
2. You will see a blank find request that looks like an entry 

without data. 
3. Type values in the fields you wish to search, then click the 

Find button in the gray navigation bar on the left, or hit the 
"Enter" key. 

4. The program will return all the entries which meet your  
find request in a 'Found Set', which you can then scroll 
through. 

 
Multiple Find RequestsMultiple Find Requests  
You can perform queries based on information in several fields 
at once. For example you may want to list all properties that 
are owned in fee simple, and that have a certain protected 
value. 
a) AND Request: In "Find Mode," fill in the information in both of 

the desired fields in the same record/request, and click the 
find button. This will return all records with both matching 
fields. 

b) Or Request: use the "Add New Request" command in the 
'Records' menu or Ctrl+N (in find mode) to return all the 
records matching either of the requests. 
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To exclude records from the request, check the omit checkbox 
on the left side of the screen in Find mode. 
  
Using The Exporting "Check Box"Using The Exporting "Check Box"   
You May use the "Check Box" in the exporting 
area of the main "Registry" form to choose 
particular entries to work with.  
This is part of the process of exporting 
new/updated information to the Land Trust 
Alliance of BC. 
 
1. Click the "Clear X" Button to de-select all previously 

marked entries. 
2. Navigate to a record you wish to export/find 
3. Place an X in the Check Box by clicking in it. 
4. Click the "Find Mode" Button and place an X in the Check 

Box as the find request. 
5. Click the Find Button on the Left, or hit the "Enter" key to 

perform the find. 
->All entries with the X selected will now be in the "Found 
Set" ready to export, delete, sort, or work with.  
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Sorting RecordsSorting Records  
 
To Sort Entries:To Sort Entries:   
Only records in the “found set” will be sorted 
1. Choose Sort from the ‘Records’ menu. 
2. In the Field List, select the name of the field you want to 

sort by and click Move to put the field name in the Sort 
Order list. 

3. Add any additional fields in the same way. 
4. Set the Sort Order by arranging the fields in the Sort Order 

list. 
5. Click on the fields in the Sort Order list and then select how 

it should be sorted (Ascending, Descending, etc.). 
6. Click Sort. The result will be the “found set” 
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View ModesView Modes  
 
The different “View Modes” can be selected from either the 
‘View’ menu at the top of the screen, or from the pop-up menu 
near the bottom left corner near the “Zoom” options. 
 
The Basic View Modes Are:The Basic View Modes Are:  
Browse Mode: Used when entering data 
Find Mode: See “Finding and Sorting” above 
Preview Mode: View what the printed document will look like. 
Flip through the pages in the navigation book on the left to flip 
through the pages of your printed document. 
  
View/Layout OptionsView/Layout Options 
All available layouts/ view options are 
listed in the “Layout” drop down menu in 
ththe upper left corner of the application, 
above the navigation book icon. 
 
For most files there is a “Edit…” layout 
and a ““Table View.” When using the buttons and forms, you will 
be in the “Edit…” layout. 
  
Table ViewTable View  
Using Table View enables you to view many entries at the same 
time in a tabular format.  This is useful when trying to locate a 
particular entry by its data, or if you wish to view and work with 
files on a larger scale.  This view is also particularly useful 
when importing and exporting data. 
Note: The functionality of drop-down lists and other "form" 
features may be limited in the "table view" display. 
 
1. From the ‘Layout’ drop down list, choose 'Table View'. 
2. To view all of your records in this table, type "Ctrl+J" or 

select "Show All Records" from the 'Records' menu. 
3. You can alter the field order by dragging the field name at 

the top of a column into the desired location. 
4. To return to the Form View, select "Edit..." from the same 

layout list.  (eg. edit ecosystems) 
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To Print RecordsTo Print Records  
 
Click the Print button on layout or select Print from the File 
menu.  Generally, using the blue Print button will erase the blue 
and grey background on the forms and will save printer ink.  
 
As mentioned in the previous section, use the “Preview” view 
mode to see how you forms/records will look when printed. 
 
• To print all pages in a found set, select “Records Being 

Browsed” in the print dialogue box.  
• To Print all records, use the Show All Records Command  so 

that all or records are being browsed. 
• To print the current record only, select ““Current Record” ” 

from the Print dialogue box. 
 
Once you've selected your print options, click OK to begin 
printing. 
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Exporting/Submitting Entries to the Land Exporting/Submitting Entries to the Land 
Trust Alliance of BCTrust Alliance of BC  

 
Only Information entered in the main "Registry" Section of the 
Protected Lands Catalogue will be sent to the LTABC. 
 
Exporting All Of Your RecordsExporting All Of Your Records  
Use this option if this is your first time exporting submissions to 
the LTABC Registry 
 
1. After completing data entry, Click the "Export to LTA" 

Button on the right of the main "Registry" section. 
2. Choose to export "All" entries and then confirm by clicking 

OK. Another message will confirm that your records have 
been saved. 

3. If you wish to send the entries to the LTABC immediately, 
choose OK from the next dialogue, and open your Internet 
connection if necessary. Otherwise click "Not Now" and 
follow directions. 

4. Once connected, click the "Continue" Button on the left 
side of the screen, which will open your default email 
program (if available). 

5. You must manually attach all of the files in your "Export 
Folder" (C:\Program Files\Protected Lands Catalogue 
v3\Export Folder\) to the email message. 

6. We would also like a photograph of each of the protected 
areas submitted to us, if available. They can be emailed 
separately, or sent to us by mail. If mailing paper 
photographs, we will scan and return the originals to you. 
See the "Technical Support" help section for our mailing 
address. 
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Exporting Selected Entries OnlyExporting Selected Entries Only   
Use this function if you've already sent entries to the LTABC 
and are submitting a new protected area that has been added 
to your Protected Lands Catalogue database. 
 
To select specific entriesTo select specific entries, simply  
1. Click the “Clear X” button to ensure that previously marked 

entries will not be exported. 
2. Place an "X" in the Exporting checkbox IN EVERY NEW 

ENTRY YOU WISH TO EXPORT. 
Note: Once an entry has been sent to the LTABC, the text 
"exported" is diplayed in the 'Exporting' section of the main 
form.  You may use the "Find Mode" and type the text 
"exported" into this field to locate records which have not 
been sent to the LTABC . However, you must still use the 
Exporting "Check Box" as described above to export only 
these records. 

3. Click the "Export to LTA" Button and follow Directions (i.e. 
Click "Selected", "Continue", and "Its Done" in the 
following prompts). 

4. Follow steps 3-6 above to send the information to the 
LTABC. 
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Importing and Exporting DataImporting and Exporting Data 
  
Importing RecordsImporting Records  
You can import data into the Protected Lands catalogue from 
many other types of database files. 
 
Important: All records must have a unique ID number! The 
"AgreementID/PLC ID" field is the main ID number within this 
program. When importing data, please verify that imported 
information has a unique ID number in the "PLC ID" field in the 
main "Registry" form. Otherwise related data may not be 
linked properly to the master file. 
1. Navigate to the database file you wish to import data to, by 

using the form buttons, or the 'Window' menu in the top 
menu bar. 

2. Select Import Records from the File menu. 
3. Navigate and open the file that will supply the imported 

records (you may have to choose the appropriate "file 
type" from the drop down list). 

4. Arrange the field names so that the lists in both columns 
line up, 

a) Manually: Select and drag the fields in the right column 
to line them up properly with the data you are 
importing. 

b) Pre-selected: Use the “View By” drop down menu in 
the upper left corner of the import dialogue tp specify 
a pre-determined order. 

Note: You can use the << and >> buttons under the left 
column to view the data in the fields of the file you are 
importing. 

5. Black arrows signify which fields will be imported. Add 
these by clicking in the centre column between the two 
field columns. 
Note: Only a compatible field type can be imported (eg. 
Number -> Number). 

6. You can type Shift+F1 for detailed help on using the Import 
Dialog box. 

7. Click Import. 
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Exporting Records:Exporting Records:   
Note: Only records in the "Found Set" will be exported! To 
export all the entries of a particular database, use the "Show 
All Records" in the 'Records' menu. Otherwise, use the "Find 
Mode" or the "Exporting" Check Box to select the data to be 
exported. 
 
Using the “Generate Export Table” optionUsing the “Generate Export Table” option  
 Generate GIS/Export Table  
 
This feature is useful if you wish to produce a data table to be 
used by other applications or people, while having access to 
export data from any table/section in your database from the 
“relationship” drop down menu above the left export column in 
the export dialogue box. 
 
Most of the commonly used fields for this type of purpose are 
pre-programmed in the export order. 
Note: When adding new fields to your export file from related 
databases, the field names may have to be renamed in the 
resulting file. This is because the related field names specify 
which file they originate from. For example, if you added the 
“ecosection” field from the “AgreementLocatons” relationship, 
the field name in your new export file would be 
“AgreementLocations::ecosection” which may look like 
“AgreementL” in a spreadsheet program like MS Excel. You 
can avoid this by using the “Export Records” command from 
the ‘File’ menu in each of the databases/sections where the 
desired fields are located. This may produce a number of 
tables, which can then be joined with the “Agreement ID” field. 
  
To Create the Export FileTo Create the Export File   
1. Perform a find request (See Finding and Sorting), to export 

only certain records, or select “Show All Records” from the 
‘Records’ menu to export all records in the database. 

2. Go to the “Land Trust Section” 
3. Click the “Generate GIS/Export Table” button 
4. Following the prompt, select the “file type”, “name”, and 

location for the new export file. 
5. Choose the Fields you wish to export (See Exporting Data in 

the next section. 
6. Click the “Export” button to populate the file.



PLC Users Guide                                                    Page 19 

How to Export Data ManuallyHow to Export Data Manually  
1. Navigate to the Main file which you are exporting 

information from by using the form buttons or the 
'Window' menu at the top of the screen. 

2. Select Export Records from the File menu. 
3. In the Export Records to File dialog box, name and save 

the file which you are creating. 
4. Choose the "File Type" of the database table that you 

are creating (eg. .tab, .dbf, .mdb etc.) 
5. In the Specify Field Order for Export dialog box, select 

the fields you want to export from the left-hand column 
and move them into the right-hand column by clicking 
on Move. 

Note: You can select fields from any of the 22 related 
databases by using the drop down list of "Relationships" 
above the left export column. 
6. By Clicking 'Clear All', then 'Move All', all the fields in 

both columns will line up. 
7. For more information on an item in this dialogue, select 

the item then press Shift+F1. 
 
Future UpdatesFuture Updates  
To allow for future updates to the Protected Lands Catalogue, 
a command script called "Show all and exit" can be found 
under the scripts menu.  This command prepares all the 
records stored in this version of the PLC for export into the 
next version.  By selecting it, it finds all records and every 
table, and then exits the program. For any new updates to the 
program, you will simply use this command, and follow 
directions. 
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FeaturesFeatures  
 
Red Listed Species UpdatRed Listed Species Updateses  
Because species that are classified as endangered or 
threatened are constantly changing, you must update the lists 
in your Protected Lands Catalogue application to stay current. 
 
You will periodically receive a file called speciesupdate.lit via 
e-mail, or you may download it from the Land Trust Alliance of 
BC's "BC Lands In Trust Registry" website 
(www.landtrustalliance.bc.ca/registry).  This file needs to be 
drag-and-dropped into your "Protected Lands Catalogue v3" 
folder on your hardrive. 
 
To Update YoTo Update Your Listsur Lists  
1. Exit the "Protected Lands Catalogue v3" program. 
2. In Windows Explorer, Navigate to C:/Program 

Files/Protected Lands Catalogue v3 
3. Drag-and-Drop the new speciesupdate.lit file into your 

"Protected Lands Catalogue v3" Folder 
4. You will be asked if you wish to replace the existing copy 

with the newer one. CLICK YES. 
5. The species lists in the PLC program will now be updated. 
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Project List Report Project List Report   
Create New Project List  

You can now easily produce a complete or categorized listing 
of the protected areas/projects which you have entered. Only 
basic information is included in this list. 
Select the “Preview” view mode to see how the entire report 
will look when printed. 
The following fields are included in the report: 
A) Project Number 
B) Common Name 
C) Signing Dates 
D) Size (ha) 
E) Agreement Type 
F) Purpose/Description 
To create a report with fields other than these, you will have to 
export data from the PLC and compose the report and format 
in another database or layout application. See the preceding 
Importing and Exporting section for further details. 
 
Note: By creating a new Project List, you will overwrite any 
previous Reports Created. Use the “Save A Copy” button if you 
wish to preserve past reports. When opening the saved copy, It 
will open in the Protected Lands Catalogue, and you will be 
able to alter the records. You may want to set the file 
properties to “Read Only” after creating it to prevent any 
modification to its records. To do this… 
1.In “Window Explorer” Right Click on the icon of the report 
copy 
2.Select “Properties” 
3.Check “Read-Only” and click OK/Apply. 
Alternatively, you can use the “Export Records” command from 
the ‘File’ menu to save the data in the report in a specified 
database format. 
 
View Last Project List Option View Last Project List Option   

View Last Project List  
Use this button/option to view the last Project List without 
making any changes to its contents. 
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Report TypesReport Types   
Full Report: This will produce a report listing all of the entries 
in the database, regardless of the “Category” chosen or the 
“Project ID”. 
Categorized Report: This report summarizes protected areas 
where there have been additional acquisitions/covenants 
made, which are related to or extend an initial protected area. 
Only entries marked with “Protected Area,” or “Summary for 
Sub Areas” in the “Category” field at the top of the Registry 
form will be included in this report. 
Categorized Report Conditions: 
A) All sub-acquisitions/projects must be marked with “Sub-

area” in the “Category” field. 
B) A Summary file for these areas must be created and marked 

with “Summary for Sub Areas” in the “Category” field 
Note: The “Area Protected” field in this summary file should be 

a total of the area protected by all of the sub areas. 
C) Project ID# field: This field MUST be used to produce a 

categorized report. All Project ID numbers of related 
protected areas must have the same ID with the 
distinguishing marker or letter at the end of the ID (eg. 
Summary= 001, Sub-Areas= 001a, 001b, 001c) 

D) Choose “Categorized” when choosing to create a New 
Project List. 

 
Customizing Your Project List LayoutCustomizing Your Project List Layout  
You can customize the appearance your project list by adding 
your logo, header text and footer text. 
Adding your Logo: Right Click in the “Container” field in the 
upper left corner of the layout, choose “Insert Picture,” browse 
to the location of your logo picture file and select it (See How 
To Use Container Fields In the Data Entry section for more 
details.) 
Adding Header and Footer Text: Simply type and format the 
text you wish to include as a Title Header and Title Footer of 
your Project List. 
Use the Preview mode to view report changes. 
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Emergency “Recover” CommandEmergency “Recover” Command  
 
In the event of a System crash, power failure, forced shut down 
or any other unnerving computer malfunction, there is a 
“Recover” Command that can rescue lost data. 
 
To Recover Lost DataTo Recover Lost Data  
Holding down the "Ctrl+Shift" keys while opening the 
Protected Lands Catalogue v3 program. Hold down the two 
keys until the recover dialogue box appear. You may have to 
re-name certain files in “Windows Explorer” to restore the 
functionality of the program (eg. remove "Copy of" and delete 
the original damaged file). 
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Technical SupportTechnical Support  
 
For Technical Support please call the Land Trust Alliance of 
BC between the hours of 9:00 am and 4:00 pm or send a fax 
anytime. 
 

Land Trust Alliance of British Columbia 
204-338 Lower Ganges Rd., 

Salt Spring Island, 
British Columbia, 

Canada 
V8K 2V3 

 
Phone (250) 538-0112 
Fax   (250) 538-0172 
Email registry@landtrustalliance.bc.ca 
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Appendix 1Appendix 1  
 
Information Displayed on the BC Lands In TrustInformation Displayed on the BC Lands In Trust  
Registry WebsiteRegistry Website  
 
The BC Lands In Trust Registry Website, is accessed by typing 
“http://www.landtrustalliance.bc.ca/registry” in the address 
bar of your web browser, or through main LTABC website by 
clicking on the “Registry” button at the top of the page. 
 
The Registry website’s navigation is based on BC’s 9 
Ecoprovinces. Each protected area submitted to the BC Lands 
In Trust Registry is represented by a red dot. By clicking on a 
protected area location (a red dot), you are able to view 
information about that particular piece of land. As the LTABC is 
aware that many of the protected areas submitted to the 
Registry are either ecologically sensitive, habitat for 
endangered species, or need to have the landowner’s privacy 
respected, only selected non-sensitive information is made 
public. The following is a list of information that will be 
viewable to the public through the registry website. 
 
• Project Common Name 
• Agreement Type 
• Covenant Holders 
• Fee Simple owner 
• Fee Simple Type 
• Acquisition/Covenant 

Dates 
• Ecogift Status 
• Property Description 
• Protected Values 
 

• Ecosystem Description 
• Regional District 
• Nearest City 
• Area Protected (ha) 
• Land Uses 
• Red Listed 

Species/Ecosystems 
• Others Sensitive 

features 
• Acquisition Partners 

Specific locations are not available to the public (i.e. co-
ordinates and addresses). As well, the scale of the maps on the 
Registry Website only depict the property’s general location 
and is not adequate to determine the actual location of the 
property. 
If there is additional information that your organization does 
not want to be made public, simply contact the LTABC to let us 
know and we will omit it from the website. 


